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Modelagem:

dilema do comeco

O comeco de qualquer projeto, ou da modelagem
de um sistema (novo ou revisitado) e sempre
marcado pelo dilema cuja metafora mais
conhecida é o do dilema se vem primeiro o ovo ou
a galinha.
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uscando um processo de
projeto

Nos casos em que intuitivamente temos um sistema que € plenamente representado
por uma rede classica, e, mais do que isso, onde este modelo ¢& facilmente e
completamente interpretado modelo, é facil de entender que somente uma demanda
por multiplos casos de simetria ou dobramento nos levaria a apelar para um sistema
de alto nivel.

No exercicio que acabamos de ver poderiamos introduzir varios tipos de peca no
processo de fabricacao, cuja “receita” seria dada por diferentes combinagoes das
operagoes utilizadas operando nas diferentes maquinas. Neste caso seria bastante
atraente a distingao de marcas por tipos. Mas sera esta a sequencia adequada em
todos os casos!
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Requisitos: o inicio de um grande
problema

Certamente o inicio de todo projeto bem sucedido ¢ a eliciagdo de um conjunto de
requisitos que descreve com precisao as funcionalidades do sistema que deve ser modelado
e implementado. Portanto para se chegar a um processo de projeto que termine na
modelagem do sistema em Redes de Petri € preciso ter em conta de que este projeto deve
comegar com uma boa representagao de requisitos.A representacao mais usada e difundida
para isso € com certeza a UML.

UNIFIED
MODELING
LANGUAGE
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Analise de Requisitos, Sintese
de redes, Building blocks

Uma hipotese bastante tentadoras seria ter um processo de projeto que pudesse
ser reduzido a uma sequencia de transformagoes de transferéncia semantica
entre linguagens, comegando pela UML. Uma rede de Petri derivada de um ou
mais diagramas UML poderia servir de base para um processo de analise
destes requisitos e mais tarde com as devidas mudancgas inseridas resultar no
modelo do sistema.

Este processo poderia perfeitamente ser combinado com o metodo conhecido
como building blocks onde varias partes da rede poderiam ser sintetizadas
como descrito no paragrafo acima ate se ter, por composicao o sistema
completo.

Prof. José Reinaldo Silva
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Casos de uso podem ser representados segundo uma forma diagramatica como

d'os Casos de

Uso

proposto em (Silva e Santos, 2004)

Symbol

Decscription

Start of a process (Use Case)

End of a process (Use Casc)

Start of an event of basic flow of process

Start of an cvent of alternative flow of process

Start of a conditional event

Jump of current iteration to iteration "

Sequence of concurrent cvents

Silva, J.R. e Santos, E.A.; Applying Petri Nets to Requirements Validation, ABCM Symposium Series in Mechatronics, vol |, pp. 508-517.
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Um exemplo: o caixa eletronico

Caso de uso textual

‘o2

N

[nitiate Withdraw — Customer inserts bank’s card in the card reader on the ATM machine

Verify Bank Card — The ATM reads the account code from the magnetic strip on the bank card and checks if it is
an acceptable bank card

Enter PIN — The ATM asks for the customer’s PIN code (4 digits)

Verify PIN — The account code and PIN are verified to determine if the account is valid and if the PIN entered is
the correct PIN for the account. For this flow, the account is a valid account and the PIN is the correct PIN
associated with this account

Select Withdraw — The ATM displays the different alternatives available at this ATM. In this flow, the bank
customer always selects “Cash Withdraw™

Enter Amount — The ATM asks for the amount to withdraw. For this flow the customer selects a pre-set amount
($10, $20, $50, or $100)

Authorization — The ATM initiates the verification process with the Banking System by sending the Card ID, PIN,
Amount, and Account information as a transaction. For this flow, the Banking System is online and replies with the
authorization to complete the cash withdrawal successfully and updates the account balance accordingly

Dispense — The Money is dispensed

Receipt — The receipt is printed and dispensed. The ATM also updates the internal log accordingly

Return Card — The Bank Card is returned

Prof. José Reinaldo Silva
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| @ Initiate Withdraw — Customer inserts bank’s card in the card reader on the ATM machine; (

1.1 < Is the card valid? Venty Bank Card 'The A'I'M reads the account code from the magnetic strip on the
bank’s card and checks if it 1s an acceptable card;
1.1.1 >Send message of invalid card — [T the card isn’tan acceptable card. send an appropriate message.

1.0

1.2 = Enter PIN — The ATM asks for the customer’s PIN code (4 digits);
1.3 < Is PIN Cormrect? — Verify PIN — The account code and PIN are verified to determine if the account is valid
and if the PIN entered is the correct PIN for the account:

1.3.1 < Is the account valid? — Verify account code — The account code is verified.,

[.3.1.1 = Send message of invalid account — The Banking system returns a code indicating the

account could net be found or is not an account which allows withdrawals, ~1-92

1.3.2 <> Is the final try? — Checks the number of tries — The customer has three tries o enter the correct
PIN:

1.3.2.1 “Send message of incorrect PIN — The ATM send an appropriate massage. ~=1-2

1.3.3 “Retain card — on the final try the card is rctained, ATM rcturns to Ready Statc, and this use casc

terminates, ~=2

1.4 <> Have moncy the ATM? — Sclect Withdraw — The ATM displays the different alternatives available at this
ATM. In this flow, the bank customer always selects “'Cash Withdraw™,

1.4.1 =Send message ATM out of Money — If the ATM is out of money, the “Cash Withdraw™ option will
not be available, ~14

1.5 <> Sufficient funds and does not exceed the daily limit? — Lnter amount — The ATM asks for the amount to
withdraw. For this tlow the customer selects a pre-set amount ($10, $20, S50, or $100);

1.5.1 < Sufficient funds? — Check sufficient funds — Check if the funds are sufficient:

[.5.1.1 =Send message insufficient funds in ATM — The ATM contain insufficient funds to

dispense the requested amount. -~1-3
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parameter Real al[:]"Vecter of ceoefficients";
final parameter Integer nx = size(a,l) - 1;
Real sigma[nx];

Real A[nx,nx] "System maLrix";

equation
A = |zerosinx-1,1), identity(nx-1);
ali:na-1] fa[na ] ;
sigma = Modelica.Math.Matrices.singularValues (i) ;

Prof. José Reinaldo Silva
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Modelagem esquematica
X

Modelagem conceitual/causal
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Exploring CPN Tools

Teoria:
modelagem
req. formais Ferramentas:
analise editor
simulador
verificador
Aplicagao:
especificacao
validacao
verificacao

implementacao

Escola Politécnica da USP
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Theory

* The Coloured Petr1 Nets formalism
— Introduction of hierarchies

* Modelling primitives
— Channels, inhibitor arcs, test arcs, ...
— Monitoring framework

* Analysis methods
— Symmetry methods
— Sweep-line method

August 27, 2002 Seren Christensen, MOCA’02

Prof. José Reinaldo Silva
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MECATRONICA

Ferramentas para Redes de Alto nivel

1990-2002 2003-...

Design CPN CPN Tools

@:& Prof. José Reinaldo Silva
( PMR5237
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1990-2002 2003-...

Aarhus Univ.,, Denmark Eindhoven Univ., Netherlands
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CPN Tools
Access/CPN

¥ Books

* Documentarian

* Dawnlasad
FAL

* Getting Started
Srace/CFN

* Know edj= Bas=

* Licensing

* Suppor:
Contact
Publcations

t= Search %

3 Like Page Tool:

Be thz ©rst of vour
friends o like this

L g i

cpntools.org

Home Download Gerting Startcc Documentaticr Support contact

CPN Tools is a tool for editing, simulating, and
analyzing Colored Petr' nets.

The too features incremental syntax checking
and code generation, which take place while a
net is being constructed., A fast simulator
efficiently hancles untimed and timec nets. Full
and perticl state spaces can be generated and
analyzed, and a standard state space report
contains ‘nformation, such as baoundedness
! preperties and liveness propertias,

New Features in Version 4.0

Declarat've constraints

3 part extensions

Simplified use of non-colored nets

Support for export to PNML

Support for real and time colorsets

Improved sunport for time (time intervals and state-space reduction)
Simplified state-space analysis

Fresh new look

¢« & & o b s 0

CPN Toc!s is originally ceveloped by the CPN Group at Aarhus University from 2000
to 2010. The main architec:ts behind the tool are Ku-t Jensen, Sdren Caristensen,
Lars M. Kristensan, and Michael \Westergaard. From the autumn of 2010, CPN Tools

is transferred to the AIS group, Eindhoven University of Technology, The
Netherlands.

Prof. José Reinaldo Silva
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Latest Version of CPN Tools

The latest released verson is version 4.0.1 from
February 2015. Get it from the Downl/oad page.

For a full list of new features for each version of
CPN Tools, Access/CPN, and Grade/CFN refer to

the Wnats New?-list.

Michael's blog on CPN Tools

e Ic Goog 2's Go-bot 2 Breakthrough for
Artificial Intelligence? (2016/03/25 22:12)
o Improved Paradigm for Analysis, Verification
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http://cpntools.org

» More information in  More information in

tokens network
— color sets, functions, etc. - possibly spaghetti networks to
— behavior may be hidden encode simple things
in “code” - behavior may be
- extreme case: all incomprehensible
behavior folded into one - cannot be parameterized
place and one transition - extreme case: (infinite) classical

Petri net

Prof. José Reinaldo Silva
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Uma outra extensao importante para as redes de Petri € o tempo. O tempo
e uma grandeza positiva que corre inexoravelmente do passado para o futuro,

isto €, desde um instante quando se comegou a contar o tempo para um
tempo futuro.

Assim, o tempo seria normalmente uma grandeza continua (teoricamente).
Entretanto o tempo de simulagao que costumamos contar € discreto e marca
tio somente a sucessio de estados. E possivel portanto ter um tempo discreto,
contado por um relogio independente dos eventos analisados.

Prof. José Reinaldo Silva
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ANALYSIS OF ASYNCUIDONOUS CONCIRRENT 3YSTEMS BY TINED PETRLU KETS

oy
Clogdey Ranchawdani

3. T=ch., Indiem Yastituts cf Tezhmology, MHew Delbhd
(136F)

5.N., Massachiserta Tnatictuze of Tachmology
(1977)

Chandler Ramchandani, em sua
dissertacao de mestrado no MIT em g
Setembro de 1973 propos a primeira Loeme o TLCaonTY

al —hwe

tempor|zag50 que S€ tem nOtICIa das NS5 ACHUSETTS THSTETUTE OF TECHKOLOGY
Redes de Petri. Bspteabe, 1973

SUFPHITTED IN PARTIAL FULFILLMENT OF °TLX

Signatire of Author_ SN N I I Y I N N A |

Deparznent of Electrizak Esgloearing, July 3, 1973
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Thesls Supscvizo:r

Accapted byl _ _ Ao A N -

~ =

Chafrnzn, Departneftel Committc: on Craduste 3-udents

APR 8 1974

[ LLLOAS
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No caso de uma Timed Petri Net estilo Ramchandani temos que uma transigao
habilitada (a proposta era basicamente para transigoes) que nao fosse
instantanea teria as marcas das pré-condigoes recolhidas a transicao e esta
ficaria habilitada e contando o tempo de simulagao ate que pudesse ser
disparada.

®

Prof. José Reinaldo Silva
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Mais recentemente estas redes sao
associadas a um tempo (real) especificado e

sao simplesmente chamadas de
Deterministic Timed Petri Nets

Escola Politécnica da USP
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Chapter 16

Timed Petri Nets

I=%é& Reinaldo S1va and Feqdro M. G d=l Foya

accrional Informaton Is 3221336 at the end of the chaptar

Il Ja 105772130117

1. Introduction
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Definition 6. [Timed Petri Net] A timed Petri net is a six-tuple
N - (PITIAIwIMOIf)
where

(P,T,A,w, M) is a marked Petri net

f: T — R" isafiring time function that assigns a positive real number to each transition
on the net

Therefore, the firing rule has to be modified in order to consider time elapses in the transition
firing. If an enabled transition ¢; € enb(M) then it will fire after f(#;) times units since it
became enabled. The system state is not only determined by the net marking but also by a
timer attached to every enabled transition in the net.

Silva, J. R. and del Foyo, PM.G.
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Michael Westergaard

Musings about Britney,
computer science,
politics, linkering, and
whatever regales me. ..

PICTURES

Ry Michael  May o4, 2015 N Cammen-s

Basic Design Principle of CPNaaS

This post has 858 words. Reading it will take approximately 4 minutes.

Raling: 0.0/5 (0 voles cesl)

CPNaaS is my new under-development
API for colored Patri nets-as-a-service,
i.e., a web-API for tools.

At the core of the APl is a RES|ful
wch scrvice. This just means that cach
resource has a unique URL, which is
manipulated as if it were a webh-page.
Web-pages are normally just obtained
for rcading (CET), but may also bc sent
information to generate extra
information (POST). Tools for editing
web-pages can additionally upload new

ON MY MIND...

Thig post hag 65 words. Reading i1

pages (PUT) or delete out-dated ones will take lege than one minute.
(DELETEL).
-e 1 1 1T M. . . v .1 . 1 . 1. ' 1 Jatiree A NI# A vratne aact)
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What 1s a model?

model and modelling
in painting, the wse of light and shade to simulate volume in the
representation of solids. In sculpture the terms denote a technique involving

the use of a pliable material such as clay or wax. As opposed to carving,
modelling permits addition as well as subtraction of material and lends itself
to freer handling and change of intention. The technique is exemplified also

by those works in cast metal and plaster that are made from the mold of a
clay original. The mold is made by the process of cire perdue. The noun
model is used to describe such an original and also any three-dimensional
scale model for a larger or more elaborate project in architecture,
landscaping, or industry. It also denotes a person or object used as an aid to
representation in painting.

The Columbia Encyclopaedia, Sixth Edition. 2001.

Abstract representation, scale model of future design

August 27, 2002 Seren Christensen, MOCA’02 v,

Prof. José Reinaldo Silva
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| desk_subprocess |

: input_pat = wait
| output_pat = done_
wait 1"Klaas HS done
Pat /://,// desk \Pat\\\
input_pat In e e output_pat [ Out
p

P Pat

Pat start stop

(p.e)@+d(e)
EP

Prof. José Reinaldo Silva
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hierarchy
inscriptions

reference
to subpage

substitution
transition

| desk_subprocess
:input _pat = walit |
| output_pat = done_
HS

port
assignment

wait 1 Klaas

Pat

Prof. José Reinaldo Silva
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reference
to subpage
port
assignment

substitution
transition

1 Klaas

| desk_subprocess
: input_pat = wait i
| output_pat = done |

wait

Pat

port type port type
fr 1"Ann
input_pat  [In_ e e output_pat [Out
p
Pat start (p.e)@+d(e) stop
port node EP port node

Prof. José Reinaldo Silva
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CPN Tools

P Wasaraby <5 SN Tuas .o

€ CH

O™ Tood
¥ Bocuman abon
¥ Coapts
*Colored nats
FEXONI COMMUNCNor
Tz onhy
Bottom.up development
Tuscn place

misrarchy tags

o cprieokong

AccoyUnoo

Sulstiuton trarmtions
Tof-Gewn davdopment
" INed Mts
¥ Evavmpde 1mis
P Graprecs! Yee Inteface
¥ T 0 CN Tools
Irstabrg O Tools
" FAQ
* Sullawy Saniun
Cortoct
Downlan:
A ition
Sugpot
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heorgtions n Hierarchical sets
UM T30S

Rennavng Meeraches conmructe

Seach| «

Homa Comnlcad Cattrg Stared Decumentation Sappor Contact

Hierarchy

Creating large, intiicote nets cas be o cumbersome tazk. But smilar to modalcr
pregramming, the consoruction of CPnats can te beobon into zmaller picces by
utlizing the Ffadlitics wthin CON Tools foe aaating sudstitetion btrang blons
Conceptuzlly, tes wth subst tition transitions ame nets with multiple lsyars of
delai - yeu can have a sonewnat simpl fied net thet gives a beoad ovarview of the
system you are modeling, and by sabstituting transitions of this top-level net with
mare detailed 2ages, you can bring neee and more detail into the madel,

Substitution transitions

In hiararchical nate thore i 8 mothad by which » transit or oan repensant 2n ortire
iove o el inictures, <o that the nat contsining e trantitioa evecites aa if the
ogic that the transitior rapreserts wer2 ohysically oresert at the location of tha
trans tion. Such 2 trarsizion is a sutstitution transiton.

Substitetion Gansitiols ajdd mothing tundamentally new. kverything trat can b2
done with them can also De Cone Dy EIng rusion places. Bul IKe Tusion places,
subsULlulion Ueansilors sk SO much wivesilence Ul Uieey can mmske Use o Meremnos
between modeling feasibility and total impossibility.

Lot vz corgider » subctituzicn ransibisn Namrac serares which coands for & net that
I usad to ovarse a list of Irtegars. 2 small bluc tag. called a subpage g, I
assoclated with the sshsti-ution transition Ressras

Rakii
T
1234 S —
wele T niol
e

Arcs surmoundng  subsdtution transitlons may o may mot have Irsalptions.
However, these Inscriptions have no semantic mezning,

Subpages and superpages

A page thar cantaing a substibtion trarsition < called A ywrnage The paga
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S € PN Tooks (Yersion 2.2.0 - September 2000)

ch-:nl tn:i)'
» Help ' Sim View Her Style |
» ODptions Binder 0 ’ - Q
¥ 00LE0N Naw P3ga i L3 a&s (o)
Stap: 0 =
Time: 0 g g :
» Options E 3 . (,) s
» History a1 0}

vDadarauons

» Standard declarations
» Monkors

Neaw Page

switch_oft swirch_on
@ 1 )89 & 1 080
4 b b@+&0 ”" ’
) Y 1°()
A ®+15 b BT
6 1) 1714
NOns
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PN Tooks (Yersaw 0l - Septerries 2008)
» Tool box
> b Sm View
» Optione | & &
v tharmostathiercon | [
Step: 0 pe —
optom &+ |0
» Opbons ‘
» Mstory
vDadaratons
»Standard dedarations &ndar O
» Nonkors man
yman
¥Yoomplete _system 1 1%

day _and nght peogram [ | @ §11s
haatirng process -

Noow

Binder 2
NeXNa_process

switch_oft switch_on

L| 1 (:003

sam_up

None

HBrvder O
compiate_systam

Binder 1

—

None

wabing _proces

Progray

None day_and_right_program

T e

Prof. José Reinaldo Silva

Escola Politécnica da USP

36

PMR5237




Make a hierarchical CPN model of five Chinese
philosophers alternating between states thinking
and eating. To eat two chopsticks are needed. In
total there are five chopsticks. The philosophers are
sitting in a circle, and need to complete for
chopsticks with their direct neighbors (left and
right). Assume that both chopsticks need to be
taken at the same time.

Model this using a hierarchical CPN model. Make
sure to model the behavior of a philosopher only
once and just use the color set BlackToken of type
unit.

Change the model such that philosophers can take
one chopstick at a time but avoid deadlocks and a
fixed ordering of philosophers.

Flatten the hierarchical CPN model. .

Prof. José Reinaldo Silva
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'color BlackToken = unit:
'var b:BackToken

— | philosopher !

| < left = CS2 |
right = CS1 |
| st 0 . o2 4
BlackToken
pH1 BlackToken
HS
PHS5 pTuBs_o;?hEr wl PH2
Ileft cs1 | =]
nght- CS5 | | philosopher |
“““ |left=CS3 |
cS5 0 CcS3 () | right = cS2_|
BlackToken BlackToken
Cs4 0 |
PHA o PH3
HS HS
philosopher ! OlackToken philosopher |
left=CS5 | left=CS4 |
nght-CS4 | nghl =CS3 |
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b)

1o At A
S

 VERONA

Esta modelagem tem dois aspectos interessantes:

nao tem muito sentido pegar os sticks e devolver logo em seguida, exceto

se retiver os sticks por algum tempo;
o estado “comendo” nao aparece explicitamente, o que indica que deve

ocorrer para cada filosofo em um nivel hierarquico mais baixo, dentro das
transicoes.

Prof. José Reinaldo Silva
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Portanto cada filosofo usa os chopsticks para passar para o estado comendo,
e, expandindo cada transi¢cao associada a ele temos:

think () eat
® )
BIackTokenC_— . BIackToken/ —
\\ //
b b b b
~ ~N
take_chopsticks & e \\\\ y Put_down_chopsticks
A \\\E E/ /// .
b \5(/
// // \\\\
left | 4 ~_ Y right

Prof. José Reinaldo Silva

PMR5237
42




X

| color BlackToken = unit;

| var b-BackToken
S —————
| lgft =(CS2
[ESRrght - c51 1o,
CS1 ‘
®
BlackToken
pH1 BlackToken
A A |
E3
PHS ! philosopher |
lioft=CS1 |
Lright = CS5 )
css ° 0
BlackToken BlackToken
CS4 ()
PHA (o *—;
(Hs]

Tohiosopher | BlackToken

left=CS5 |

ight = CS4 |

i 9
 MERONIA

think 0 [

t
BlackToken

b b
; I
i:‘;“i@; : take_chopsticks ‘ put_down_chopsticks
Lt |
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" CPN Tools

» Tool box
» Healp
» Options
¥ DiningPhilosophersClassic.cpn
Step: 0
Time: 0
» Options
» History
¥ Declarations
¥ colset UNIT = unit;
» Monitors
Ymain
philosopher (5)
philosopher (1)
philosopher (2)
philosopher (3)
philosopher (4)

Binder 0

main philosopher(1) philosopher(2) philosopher(3) philosopher(4) philosopher(S)

Sim View S§§S

«(H)o M| [pp /s

philosophers

philosopher
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philosopher4

I philosopher3
ohiosopher

UNIT

—
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Hier
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O+ O« O] ©
1
()
Frae
Chopstick
UNIT
philospherl
yulosopher
1
E ()
UNIT

philosopher2

el

NIOSO
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»Tool box
»Help
» Options
¥ DiningPhilosopharsClassic.oon
Step: 0
Time: 0
» Opticns
» History
¥ Declerations
v colset UNIT = unit;
» Monitors
¥ main
philosopher (5)
philosopher (1)
philosopher (2)
philosopher (3)
philosopher (£)
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[ CPN Tools (Version 3.0.2 January 201 C=mror )

Binder 0
mzin  philosopner(l) philosopher(2) philosopher(3) philosopher(4) philosopher(s]

Hiar

n_ | %
By
Sim View 5§

QDo M b oy

Q
0]

e
o

(El

Put Down
Chopsticks

Take
Chopsticks

—— e T ey T
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CPN Tools (Version
» Tool box
» Help Binder 0
- Opbons page
¥ DinnaPhilosophersClassic.con
Step: 0 Sim View
O <(HDo M | b pp)m
o optlonS ’ Put Down
» History Chopsticks1 ()
vDeadarations (()— N
¥ colsat UNIT = unit; 0]
» Monitors 0
Paqe ()
Eatl Think1 §1)
UNIT UNIT
()
1)
() 0 Take 0
Put Down Free Chopsticks1 Frae Put Down
ChopsticksS [ () Chopstick! Chopstick () Chopsticks?2
UNIT UNIT Eat2 -
0 0 ot U
()
()
. Take 1
Take - v ()
@ [) | Chopstickss Chopsticks2 ()
UNIT
()
1)
()
Frae
Chopstick2
IT
0
Take
Take Chopsticks3 L ()
Chopsticks4 -
Think4 11, 0 0 Eat3
UNIT 1 0 () ‘(’;“T A
0 Free Think3 &
Chopstick UNI
Put Down 0 UNIT Put Down
Chopsticks4 () Chopsticks3
()
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Inserindo funcoes

Uma maneira de incrementar as inscricoes € incluir elementos
de “ordem” superior a que temos até agora (variaveis,
expressoes, elementos logicos basicos, if-then-else, etc.).

Uma fungao € associada a um identificador e uma assinatura que
especifica o tipo dos argumentos e o tipo do valor de retorno.

Prof. José Reinaldo Silva
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Introduziremos tambem o conceito de lista.

Uma lista e uma estrutura homogenea (todos os componentes
sao do mesmo tipo), composta de uma sucessao de elementos.

, ¢, d, e, f,

Exemplo: [a,b g]
1,2,4,6,7,10]

[1,

Prof. José Reinaldo Silva
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Uma lista tambem pode ser definida de forma recursiva, como
sendo composta de dois elementos basicos. Para isso definiremos
em primeiro lugar a lista vazia [ ].

Uma lista nao vazia € composta por dois elementos: head, que € o
primeiro elemento da lista e tail que € uma lista (necessariamente

menor que a lista original), e se representa como [head | tail].
No exemplo dado anteriormente,

[a,b,c,d,e,f,g] =m= [a]|][b,c,defg]]

[1,2,4,6,7,10] === [l |[24,6,7, 10]]

~ Prof. José Reinaldo Silva
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fun totalstock(s:Stock) =
if s=[]
then 0

else (#number(hd(s)))+totalstock(tl(s));
J
| color Product = string; |
| color Number = int; |
| color Stockltem = record prod:Product * number:Number; |
| color Stock = list Stockltem; |
| var x:Stockltem; |
| var s:Stock; |
| fun incrs(x:Stockitem,s:Stock) = if s=[] then [x] else (if (#prod(hd(s)))=(#prod(x)) |
then {prod=(#prod(hd(s))),number=((#number(hd(s)))+(#number(x)))}::ti(s) I
else hd(s):: incrs(x,ti(s)));
fun decrs(x:Stockltem,s:Stock)= incrs({prod=(#prod(x)),number=(~(#number(x)))},s), |
fun check(s:Stock)= if s=[] then true else if (#fnumber(hd(s)))<0 then false |
else check(tli(s)); |
val initstock = [{prod="bike", number=4} {prod="wheel", number=2}, |
| {prod="bell", number=3}, {prod="steering wheel", number=3}, |
|_{prod="frame", number=2}; |

1" {prod="bell",
in umber=3} ) s StM\itstock . [c:eck(descrs(x,s))] y
. X
X .
Stockitem ncrease ") Stock JoSCrE%S)  Jecrease Stockltem
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color Product = string;

color Number = int;

color Stockltem = product Product*Number,;
var p:Product;

var x:Number;

var y:Number;

1°("bike" 4)++
1'("wheel",2)++

1°("bell",3)++
1°("steering wheel",3)++
: 1°("bell",2) 1°("frame",2) [y>=Xx]
n <« (PY) St°/°k——\' = (P.y) (p.X) COU“
@(D—,X)’ (p x+y) w (p y_x)
Stockltem increase ’ Stockltem ’ decrease Stockltem

Note the simplicity/elegance of the arc inscriptions.
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Function
has two
arguments -~

7

Recursion (4)

o ‘R\v)\ ) /k_/"
fun enoughstock(s:Stock,n:Number) = ~—
ifs=1[]
then [ ]

else if (#number(hd(s)))>= n then hd(s)::enoughstock(ti(s),n)

else enoughstock(ti(s),n);

"apple” 301 "orange" 504
"orange" 504 n=400 "pear” 423
"pear" 423 #

‘banana” 134
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PN Tan s
Accsss/ TP
* Books
* Dozumentat on
" Dawnlsad
FAQ
¥ Getting Started
Frst sicps
Grade/CPN
F Kncwledge Bass
*Lesrsing
*Suzo
Chatast
FLblicztiors

4 Gearch | ¥

N\ 'Tools

Bl Lika FPage

ar *he fi~ss of waur
frleads ol kaths

5 kg §!

Home  Dowsload — Getting Started = Documertation  Supsort  Contack

Getting Started

Modeling With Coloured Petri Nets

In all of the falewing and on all of thess pages, we assume that you are familiar with
colcurec Petr nets are have at |east some idea of constructing modules using the
farmealism. You cer learm mare aboaut the modeling enc the formalism r one or both of
thece books:

Maonolrg

Busiress Procoszes
/. Pew Lo Grend fppmmb

Looured

el Mats

e

The User Interface of CPN Tools

Sirst steps

sy .|~'.e|[aw

Graphica User [ateface

Index

Marking menus
Other tools
Palette tools
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